UPGRADE YOUR BUSINESS

by upgrading to new Dell"OptiPlex"desktops powered by Intel’

DELL OPTIPLEX
9030 ALL-IN-ONE

FASTER OUT-OF-BAND
MANAGEMENT

97% lower IT costs with Dell
Command | Intel vPro" Out of Band

LESS WAITING WHILE WORKING
Up to 145% better system performance

LOWER POWER COSTS

Up to 60% lower power consumption

DELL OPTIPLEX IN OUR HANDS-ON TESTS vs
9020 MICRO PC A 5-YEAR-OLD LEGACY DESKTOP

Aging desktops present obstacles as they lack the latest hardware and software
technology. Your business faces a difficult decision: You can replace those older
desktops now, or you can push the capital expense to the next fiscal year. How do you
know when it’s the right time to invest in new technology for your business?

We examined the advantages of upgrading to the Dell OptiPlex 9030 All-in-One
and Dell OptiPlex 9020 Micro from a representative five-year-old desktop tower system.
We found that the Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro offered
compelling reasons to upgrade, including support for remote systems management,
much faster performance for increased productivity, and significantly lower power
consumption.

Upgrading to Dell OptiPlex desktops brings many benefits to your business. Your
IT can leverage Dell technology to save time and reduce costs when supporting out-of-
band systems. Your employees have the opportunity to be more productive with faster

and more power-efficient desktops that also enable your business to lower power costs.

» B MARCH 2015
‘ I A PRINCIPLED TECHNOLOGIES REPORT

Commissioned by Dell Inc.


http://www.principledtechnologies.com/

FASTER OUT-OF-BAND MANAGEMENT WITH DELL COMMAND | INTEL
VPRO OUT OF BAND

Manage desktops remotely and regardless of state with out-of-band management
Remote management has traditionally relied on in-band management, which
requires each managed device to fully load its operating system (OS) and receive
commands through a software-based management agent. With out-of-band (OOB)
management, IT staff can now use a special hardware-based channel to connect with
the device remotely when the OS is unreachable. Specifically, OOB management can
happen when a system is in any of the following conditions:* 2
e the system is plugged in but not actively running (i.e., powered off or
“asleep”)
e the operating system has not loaded
e the system is booted into its operating system and the software-based
management agent is not available
e the system is hung or non-operational

0O0B management functionality is valuable in situations that necessitate
accessing, updating, or restoring multiple remote systems that IT staff cannot otherwise
reach. For example, if vicious malware infects and corrupts the operating systems of
many desktops and begins to propagate, IT staff need to shut down the systems to stop
further infection. Using OOB management with hardware-based Keyboard-Video-Mouse
(KVM) Remote Control, IT staff can access the infected desktops while they are offline,
and then correct the problem by configuring the systems to boot to a separate drive or
by redirecting them to run an executable.

Intel Core™ vPro processors offer a hardware-based option for OOB
management with the Intel Management Engine, an isolated and protected coprocessor
that can communicate with the network and draw power independently of the system’s

main components.?

Save time and lower IT costs with common management tasks
With legacy desktop towers that are out-of-band, IT staff have to make physical
deskside visits to perform common management tasks, one system at a time. This
means more time and associated costs to complete the tasks. With new Dell OptiPlex
desktops, however, your IT staff can apply changes to multiple systems simultaneously

and remotely, regardless of their current power state.

! en.community.dell.com/techcenter/extras/m/white papers/20179305/download.aspx
2 www.intel.com/content/www/us/en/architecture-and-technology/vpro/vpro-technology-general.html
3 www.kernel.org/doc/Documentation/misc-devices/mei/mei.txt
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We looked at the amount of time your IT staff could save when managing a
group of Dell OptiPlex 9030 All-in-One or Dell OptiPlex 9020 Micro desktops instead of a
group of legacy desktop towers. We timed how long it took to complete five OOB
management tasks on the Dell OptiPlex desktops using an SCCM management
environment and Dell Command | Intel vPro Out of Band, and then timed how long it
took to complete the same tasks manually on the legacy desktop tower. Figure 1 shows
the amount of time your IT staff can save for common OOB management tasks with 50
systems when you upgrade to new Dell OptiPlex desktops; more efficient management

can reduce IT labor time by up to 97 percent.

Reduce IT time to complete management tasks
with new Dell OptiPlex desktops

Change one B 12

BIOS setting 47.8

Change five B 15
Figure 1: Amount of IT time to BIOS settings 55.1
complete five separate management Change B 12
tasks on 50 systems, in minutes. boot order 35.1
Lower numbers are better. Change P13

BIOS password 53.0
powesreptroﬂle i 11 46.0

W Dell OptiPlex desktops with Dell Command | Intel vPro Out of Band

Legacy desktop towers with deskside visits

Saving time with new Dell OptiPlex desktops when completing common OOB
management tasks ultimately means savings in labor costs. For example, we found that
new Dell OptiPlex desktops could save your business over $35 in IT labor costs for the
simple task of changing a BIOS password for 50 systems. Figure 2 shows the lower costs
that your business can realize with OOB management tasks when upgrading to new Dell
OptiPlex desktops.*

4 We estimated an IT cost of $.6635 per minute, based on an average annual total compensation estimate from Salary.com of
$82,809 for a Help Desk Support senior-level position.
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Lower IT costs to complete management tasks
by replacing desktops

Changeone || $0.80
BIOS setting $31.72

Change five [ $1.00
Figure 2: Cost of IT to complete five BIOS settings $36.56

separate management tasks on 50 Change ] $0.80
systems, in dollars. Lower numbers boot order $23.29

are better. Change B s0.86

BIOS password $35.17

Set l s0.73
power profile $30.52
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Legacy desktop towers with deskside visits

Reduce repair costs and employee downtime when supporting a non-operational system at
a remote site

IT can resolve some problems for a non-operational Dell OptiPlex desktop
remotely with OOB management that previously would have required an expensive
deskside visit to a remote site with a legacy desktop tower. The travel time for a
deskside visit ultimately increases the cost and overhead for IT to make a repair, and
increases employee downtime and lost productivity.> ® With hardware-based KVM
Remote Control and OOB management, IT staff can remotely access the target desktop
and implement the necessary changes as soon as possible.

We considered an example 10-minute repair of a single non-operational system
to illustrate the potential IT savings with new Dell OptiPlex desktops for a single repair
at a remote site. When repairing a legacy desktop tower, the one hour of total travel
time to and from the remote site in this scenario represents a significant amount of
overhead for IT. With the Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro, IT
could simply launch a KVM Remote Control session—a process that we found took only
15 seconds.

5 The Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro in our study included the latest Intel vPro technology and the latest
version of Intel Active Management Technology (Intel AMT). For more information on Intel AMT, visit
www.intel.com/content/www/us/en/architecture-and-technology/intel-active-management-technology.html?wapkw=amt.

6 The legacy desktop tower in our study shipped with an older release of Intel AMT (5.2), which meant that it did not support
hardware-based KVM Remote Control.

software.intel.com/sites/manageability/AMT Implementation_and_Reference Guide/default.htm?turl=WordDocuments%2Fkvman
dintelamt.htm
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We also looked at the amount of employee downtime for this example 10-
minute repair of a single non-operational system. With the legacy desktop tower, the
employee would have to wait until the following business day for a deskside visit,
representing eight business hours of downtime after the initial call. With the Dell
OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro, the employee would have to
wait only 15 seconds for IT to initiate the KVM Remote Control session.’

Figure 3 shows the total amount of employee downtime and IT labor for a single
repair of a non-operational system at a remote site. Replacing desktops would enable IT
to reduce employee downtime significantly and reduce overhead for IT staff when
supporting a non-operational system. Instead of waiting eight business hours for the
repair, the employee could get back to work much sooner. In addition, quicker repairs

give IT staff more time to complete other tasks.

Reduce employee downtime and IT labor
with new Dell OptiPlex desktops

Lost productivity

due to employee I 0:10:15
Figure 3: Lost productivity due to downtime for a 8:10:00
employee downtime and IT labor repair o
for a single repair of a non-
operational system at a remote site,
in hours:minutes:seconds. Lower IT labor for a I 0:10:15
numbers are better. repair 1:10:00

Time (hours:minutes:seconds)
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Legacy desktop tower with deskside visit

Figure 4 shows the value of the reduced employee downtime and the value of
the time IT could save with the Dell OptiPlex 9030 All-in-One or Dell OptiPlex 9020 Micro
for a single repair of a non-operational system at a remote site. The Dell OptiPlex 9030
All-in-One or Dell OptiPlex 9020 Micro would reduce the cost of employee downtime by
$215.08 for a single 10-minute software repair—a savings of nearly 98 percent.® The 10-
minute software repair would cost $39.65 less with the Dell OptiPlex 9030 All-in-One or

7 We assumed an equal amount of time for IT to generate the support ticket with KVM Remote Control and the deskside visit, and
did not include that time in our analysis.

8 We estimated an average end-user cost of $.4483 per minute, based on an average annual total compensation of $55,954.00,
which includes an average 2013 US salary of $43,041.39 (www.ssa.gov/OACT/COLA/AWI.html) plus 30 percent in benefits.
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Dell OptiPlex 9020 Micro due to the elimination of IT travel time—a cost savings of 85

percent.’

Lower costs with reduced employee downtime
and IT labor by replacing desktops

Cost of IT staff labor I $6.80
Figure 4: Cost of lost productivity due

to employee downtime and cost of IT forarepar $46.45
labor for a single repair of a non-
operational system at a remote site, Value of lost
in US dollars. Lower numbers are productivity due to I $4.60
better. employee downtime $219.68
for a repair
Dollars (US)

m Dell OptiPlex desktops with Dell Command | Intel vPro Out of Band
Legacy desktop tower with deskside visit

LESS WAITING WHILE WORKING WITH DELL OPTIPLEX DESKTOPS

Promote productivity with up to 145% better system performance

Waiting on a slow PC can be painful. A faster, more responsive desktop means
your employees can finish the same tasks in less time, ultimately providing your
employees an opportunity to be more productive. We used five industry-standard
benchmarks to show the performance boost your employees can get with a new Intel
processor-based Dell OptiPlex 9030 All-in-One or Dell OptiPlex 9020 Micro. The new
Intel processor-powered desktops outperformed the legacy desktop tower on all of the
performance benchmarks.

For detailed specifications of the test systems, see Appendix A. For step-by-step
details on how we performed our benchmark testing, see Appendix D. For more on the
benchmarks, see Appendix E.

As Figure 5 shows, we found the Dell OptiPlex 9030 All-in-One and Dell OptiPlex
9020 Micro provided significantly better system performance than the legacy desktop
tower—145 percent and 114 percent, respectively. Note: We calculated the percentage
wins for the Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro on each

benchmark, and then calculated system performance by taking the geometric mean of

9 We estimated an IT cost of $.6635 per minute, based on an average annual total compensation estimate from Salary.com of
$82,809 for a Help Desk Support senior-level position.
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Figure 5: System performance for
Dell OptiPlex 9030 All-in-One and
Dell OptiPlex 9020 Micro vs. the
legacy desktop tower. Higher
numbers are better.

Faster desktops for your
employees mean less
waiting while working
and an opportunity for
increased productivity.

.

those percentage wins versus the legacy desktop tower. For more details on how we
calculated the system performance, see Appendix B.

Increase performance
with new Dell OptiPlex desktops

the Dell OptiPlex

9030 All-in-One 145.3%

Dell OptiPlex

9020 Micro 114.1%

So what does better system performance mean for your business? If your
average employee spends 10 minutes a day waiting to do the types of tasks included in
the benchmarks (e.g., writing documents, browsing Web sites, and creating
spreadsheets), 145 percent better system performance means your average employee
could save almost 23 hours per year when moving from the legacy desktop tower to the
Dell OptiPlex 9030 All-in-One. As Figure 6 shows, replacing desktops represents a
significant opportunity for increased productivity as the size of the desktop fleet
increases. For example, a business replacing 10,000 legacy desktop towers with 10,000
new Dell OptiPlex 9030 All-in-One desktops could see significant savings over four
years—5.923 minutes saved daily per employee would add up to over 900,000 total

hours saved that employees could use for other tasks.'® 1

0 Based on a conservative estimate that a hypothetical mix of productivity tasks would take an average of 10 minutes per employee
per day with the legacy desktop tower. With 145.3 percent better system performance, the same mix of tasks would take an average

of 4.077 minutes per employee per

day with the Dell OptiPlex 9030 All-in-One, saving 5.923 minutes per employee per day.

11 Based on a 46-week work year per employee, which includes holidays, vacation, and sick leave (www.bls.gov/opub/btn/volume-

2/paid-leave-in-private-industry-ov

er-the-past-20-years.htm).
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Promote productivity by replacing desktops

9,080,000

Figure 6: Time saved in hours over
four years when replacing a fleet of
legacy desktop towers with Dell
OptiPlex 9030 All-in-One desktops.

Time saved over four years (hours)

0 20,000 40,000 60,000 80,000 100,000
Number of desktops

PAY LESS FOR POWER WITH DELL OPTIPLEX DESKTOPS

Save at the outlet with up to 60% fewer watts at idle and up to 42% fewer watts under load
Why waste energy and dollars with inefficient older desktops? We found that
/ \ both the Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro consumed
The Dell OptiPlex 9030
All-in-One and Dell
OptiPlex 9020 Micro
consumed less power

significantly less power than the legacy desktop tower—and, notably, consumed less
power under load than the legacy desktop tower consumed at idle. The Dell OptiPlex

9030 All-in-One consumed 55 percent fewer average watts while idle and 35 percent

under load than the fewer average watts under load than did the legacy desktop tower. The Dell OptiPlex

legacy desktop tower 9020 Micro consumed 60 percent fewer average watts while idle and 42 percent fewer

consumed at idle. average watts under load than did the legacy desktop tower. Figure 7 shows the power
\ / usage of all three systems while idle and under load.
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Increase power efficiency
with new Dell OptiPlex desktops

87.2
64.9 Idle
Figure 7: The average number of E 56.3
watts each system consumed while 2 50.6
idle and under load. Lower numbers En
T
are better. g 28.8 250 ®m Under
=g . load
Dell OptiPlex 9030 Dell OptiPlex 9020 Legacy
All-in-One Micro desktop tower

As Figure 8 shows, replacing older inefficient desktops can significantly affect
the bottom line. For example, a business replacing 10,000 legacy desktop towers with
10,000 new Dell OptiPlex 9020 Micro desktops could realize significant savings over four
years; $7.65 saved annually per employee would add up to $306,000 total savings in
power costs.?

Save at the outlet by replacing desktops

$3,500,000 $3,060,000
$3,000,000

Figure 8: Power consumption savings $2,500,000
in dollars over four years when
replacing a fleet of legacy desktop
towers with Dell OptiPlex 9020 Micro

desktops.

52000000 $1,530,000

$1,500,000
$1,000,000
$500,000
S0

$153,000

Value of power consumption saved
over four years (US dollars)

0 20,000 40,000 60,000 80,000 100,000
Number of desktops

12 Based on a conservative estimate of one hour under load and seven hours idle for average power consumption per employee per
day, 46-week work year per employee, and average US commercial power costs of $0.1075 per kilowatt-hour from the U.S. Energy
Information Administration (www.eia.gov/electricity/monthly/pdf/epm.pdf).
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LEVERAGE THE NEWEST TECHNOLOGY WITH DELL OPTIPLEX DESKTOPS

Gain the benefits of touch
Touch-interactive technology is becoming as popular in the office as it is at

home. An Intel study shows respondents overwhelmingly preferred laptops with

touch,®® and shipments of touchscreen monitors are seeing growth.*

If a touchscreen delivers Microsoft® Windows® 8.1 does not require touch technology, but a touch-
a productivity benefit of

one minute per day
with the Dell OptiPlex

enabled version of the operating system can allow users to access information,

collaborate, and make presentations through quick touch gestures. For the Dell OptiPlex

9030 All-in-One, it could 9030 All-in-One with the included touchscreen display, users can engage content such as

pay back its added cost Web pages, images, videos, pdfs, and email with touch-enabled apps such as Microsoft

in under 20 months. Office 365™, and then switch to the keyboard and mouse for typing and editing content,
\ / choosing the more comfortable interface for each task.

For the Dell OptiPlex 9030 All-in-One that we tested, the touch-enabled display
added $186 to the starting price over a similarly configured model without touch.® If
the touchscreen on the Dell OptiPlex 9030 All-in-One can deliver a productivity benefit
of just one minute per day, the optional touch capability could pay back its added cost in
under 20 months.® 7

Connect via USB 3.0, DisplayPort, HDMI, and Wireless AC

Replacing desktops can enable your business to take advantage of the latest
USB technology. The Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro
included USB 3.0 ports—eight and six, respectively. The legacy desktop tower offered
USB 2.0 ports. USB 3.0 ports, such as those on the two Intel processor-powered
desktops, can provide up to 4.8 Gbps transfer rates to USB 3.0 devices—up to 10 times
faster than the transfer rate for USB 2.0 connections to USB 2.0 devices that you could
get with the legacy desktop tower.

Replacing desktops can also bring the latest display technology to your business.
In addition to the touchscreen display on the Dell OptiPlex 9030 All-in-One, both the
Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro included DisplayPort, which

13 www.neowin.net/news/intel-80-percent-of-pc-users-prefer-touch-screens and www.intelfreepress.com/news/do-people-want-
touch-on-laptop-screens/197/

14 www.businesswire.com/news/home/20141215006340/en/Worldwide-PC-Monitor-Market-Aided-Touch-Screen#.VIPVgCsgBg
15 The starting price ($1,598) + three-year ProSupport Service brought the price to $1,677.57 for non-touch-enabled display with
Intel Core i5 processor and 8 GB memory for the Dell OptiPlex 9030 All-in-One. The starting price (including three-year ProSupport
Service) for the Dell OptiPlex 9030 All-in-One with the same processor and memory and touch-enabled display was $1,863.29 via
www.dell.com/us/business/p/optiplex-9030-aio/fs?pf=v on 12/19/2014.

16 A minute a day, valued at $9.72 ($350/36), per month could provide payback for a $186 cost in 19.1 months.

17 Note: We tested the Dell OptiPlex 9030 All-in-One installed with Windows 7 so that system configuration matched closely to the
legacy desktop tower. The Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro are available with either Windows 7 or
Windows 8.1.
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can support higher performance and lower power monitor displays than the legacy
desktop tower we tested. The Dell OptiPlex 9030 All-in-One also offered HDMI—either
DisplayPort or HDMI on the Dell OptiPlex 9030 All-in-One can be used to add a second
display.

Replacing desktops can also boost your business with the latest in wireless
technology. The Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro both
included Intel Dual Band Wireless-AC 7260 cards, while the legacy desktop tower we
tested did not include a wireless card. Replacing a fleet of legacy desktop towers
without wireless cards provides more flexibility by removing the requirement of an

Ethernet port and cable for each desktop.

Save workspace with All-in-One and Mini form factors

Upgrading to new Dell OptiPlex desktops can also offer workspace savings for
your business. As Figure 9 shows, the Dell OptiPlex 9030 All-in-One and Dell OptiPlex
9020 Micro required significantly less workspace than the legacy desktop tower in our
study—59 and 60 percent less square inches, respectively. In addition, Dell offers
mounts for the OptiPlex 9020 Micro that can further reduce its required workspace,
creating more space savings when compared to the legacy desktop tower. Note: For
more details on how we calculated workspace for the three systems, see Appendix C.

New form factors mean workspace savings
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Dell OptiPlex 9030 Dell OptiPlex 9020 Legacy desktop tower

All-in-One Micro

As Figure 10 shows, the workspace savings that replacing desktops can bring
your business can have an enormous impact at scale. For example, a business replacing
10,000 legacy desktop towers with 10,000 new Dell OptiPlex 9020 Micro desktops could

save 7,708 sq. ft. of valuable workspace.
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Significant workspace savings
with desktop replacement

90,000
80,000
70,000
60,000
50,000
40,000
30,000
20,000
10,000

77,083

Figure 10: Workspace saved in square
feet when replacing a fleet of legacy
desktop towers with Dell OptiPlex
9020 Micro desktops.
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CONCLUSION

Compared to aging desktops, new Dell OptiPlex desktops can allow employees
to be more productive with faster and more reliable hardware while providing
significantly lower power costs. Improved management technology with the new
desktops can support the efforts of your IT staff and can reduce costly deskside visits.
Upgrading your aging desktops with the Dell OptiPlex 9030 All-in-One or the Dell
OptiPlex 9020 Micro desktops brings important improvements to your business through

both hardware and software.
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APPENDIX A — SYSTEM CONFIGURATION INFORMATION

Figure 11 details the systems we used in our tests.

Dell OptiPlex 9030 All-

Dell OptiPlex 9020

System in-One Micro Legacy desktop tower
General

Number of processor packages 1 1 1

Number of cores per processor 4 4 2

Number of hardware threads per 1 1 1

core

Total number of processor threads 4 4 )

in system

System power management policy | Balanced Balanced Balanced

Processor power-saving option EIST EIST EIST

Dimensions (h x | x w in inches)

20.50 x 22.25 x 8.50

1.50x7.38 x7.19

17.63 x 17.38 x 7.00

Weight (Ibs.) 24.1 2.5 23.8

CPU

Vendor Intel Intel Intel

Name Core i5 Core i5 Core 2 Duo
Model number 4590S 4590T E8400
Stepping Cco Cco EO

Socket type Socket 1150 LGA Socket 1150 LGA Socket 775 LGA
Core frequency (GHz) 3.0/3.7 Turbo 2.0/3.0 Turbo 3.0

Bus frequency DMI2 5 GT/s DMI2 5 GT/s 1,333 MHz

L1 cache 4x32KB+4x32KB 4x32KB+4x%x32KB 2x32KB+2x32KB
L2 cache 4 x 256 KB 4 x 256 KB 6 MB

L3 cache 6 MB 6 MB N/A

Platform

Vendor and system name

Dell OptiPlex 9030 All-
in-One

Dell OptiPlex 9020
Micro

HP Compaq 8000 Elite
Convertible Minitower

Motherboard model number

OVNGWR

0Y5DDC

3647h

Motherboard chipset

Intel Q87

Intel Q87

Intel Q45/Q43

BIOS name and version

Dell AO3 (09/15/2014)

Dell A2 (08/11/2014)

Hewlett-Packard
786G7v01.13
(07/20/2011)

AMT Version

5.2.50

9.1.0

9.1.0
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System Dell Optil:-lg)r(‘ :030 All- Dell Of\;lli::ix 9020 i (e
Memory module(s)
Samsung® Hyundai Electronics Samsung
Vendor and model number M471B5173DB0-YKO HMT41GS6BFR8A-PB M378B5673EH1-CHI
Type PC3-12800 PC3-12800 PC3-10600
Speed (MHz) 1,600 1,600 1,333
Speed running in the system (MHz) | 1,600 1,600 1,066
Timing/Latency (tCL-tRCD-RP- 11-11-11-28 11-11-11-28 7-7-7-20
tRASmMIn)
Size (MB) 4,096 8,192 2,048
Number of memory module(s) 2 1 2
Total amount of system RAM (GB) | 8 8 4
Channel (single/dual) Dual Single Dual
Hard disk
Vendor and model number Seagate® ST500LT012 Samsung PM851 SSD Seagate ST3320418AS
Number of disks in system 1 1 1
Size (GB) 500 128 320
Buffer size (MB) 16 N/A 16
RPM 5,400 N/A 7,200
Type SATA 6.0 Gb/s SATA 6.0 Gb/s SATA 3.0 Gb/s
Int.eI 8 Series:/C220 Int.eI 8 Series:/C220 Intel Express Chipset
Controller itll(r:)lset Family SATA gljllglset Family SATA SATA RAID Controller
Driver Intel 12.8.7.1000 Intel 13.0.0.1098 Intel 10.1.0.1008
(10/18/2013) (02/05/2014) (11/06/2010)
Operating system
Name Windows 7 Windows 7 Windows 7
Professional x64 Professional x64 Professional x64
Build number 7600 7600 7600
Service Pack 1 1 1
File system NTFS NTFS NTFS
Kernel ACPI x64-based PC ACPI x64-based PC ACPI x64-based PC
Language English English English
Microsoft DirectX® version 11 11 11
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System

Dell OptiPlex 9030 All-
in-One

Dell OptiPlex 9020
Micro

Legacy desktop tower

Graphics

Vendor and model number

Intel HD Graphics 4600

Intel HD Graphics 4600

Intel GMA 4500

Type Integrated Integrated Integrated
. Intel HD Graphics Intel HD Graphics Intel 4 Series Express

Chipset . . . .
Family Family Chipset Family

BIOS version 2179.5 2179.1 2066.0

Total available graphics memory 1696 1,696 1,695

(MB)

Dedicated video memory (MB) 64 64 64

System video memory (MB) 0 0 0

Shared system memory (MB) 1,632 1,632 1,631

Resolution 1,920 x 1,080 1,920 x 1,080 1,920 x 1,080

Driver Intel 10.18.10.3412 Intel 10.18.10.3412 Intel 8.15.10.2413
(01/29/2014) (01/29/2014) (06/03/2011)

Sound card/subsystem

Vendor and model number

Realtek® High
Definition Audio

Realtek High Definition
Audio

Realtek High Definition
Audio

Driver

Realtek 6.0.1.6053
(10/16/2014)

Realtek 6.0.1.6032
(04/25/2014)

Realtek 6.0.1.6383
(05/31/2011)

Ethernet

Vendor and model number

Intel Ethernet
Connection 1217-LM

Intel Ethernet
Connection 1217-LM

Intel 82567LM-3
Gigabit Controller

Intel 12.12.50.4

Intel 12.12.50.7205

Intel 12.10.13.0

Driver (06/12/2014) (07/31/2014) (12/16/2013)
Wireless
Intel Dual Band Intel Dual Band
Vendor and model number Wireless-AC 7260 Wireless-AC 7260 N/A
. Intel 17.0.5.8 Intel 17.0.5.8
Driver (06/18/2014) (06/18/2014) N/A
Optical drive(s)
Vendor and model number TSSTcorp SU-208FB N/A HP TS-H653R
Type DVD-RW N/A DVD-RW
USB ports
Number 8 6 10
Type 3.0 3.0 2.0
Media card reader,
Other DisplayPort, DisplayPort N/A
1 x HDMl In,
1 x HDMI Out
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Dell OptiPlex 9030 All-

Dell OptiPlex 9020

System in-One Micro Legacy desktop tower

Monitor

Model Dell All-in-One Touch Dell P2314H ViewSonic® VG730m
Display

LCD type Backlit LED Backlit LED SXGA LCD

Screen size 23" 23" 17"

Refresh rate (Hz) 60 60 60

Maximum resolution 1,920 x 1,080 1,920 x 1,080 1,280 x 1,024

Figure 11: Detailed information for our test systems.

Figure 12 describes the configuration of the server that we used to access the desktops for management tasks.

System Dell PowerEdge™ R620
Power supplies

Total number 2

Vendor and model number Dell D750E-S1
Wattage of each (W) 750

Cooling fans

Total number 7

Vendor and model number Delta® GFC0412DS
Dimensions (h x w) of each 1-1/2" x 1-3/4"
Volts 12

Amps 1.82

General

Number of processor packages 2

Number of cores per processor 8

Number of hardware threads per core 2

System power management policy Default

CPU

Vendor Intel

Name Xeon®

Model number E5-2660

Socket type LGA 2011

Core frequency (GHz) 2.20

Bus frequency 8

L1 cache 32 KB + 32 KB (per core)
L2 cache 256 KB (per core)
L3 cache 20 MB

Platform

Vendor and model number

Dell PowerEdge R620

BIOS name and version

Dell 2.4.3 (10/10/2014)

BIOS settings

Default
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System

Dell PowerEdge™ R620

Memory module(s)

Total RAM in system (GB) 128

Vendor and model number Micron® MT36KSF1G72PZ
Type PC3-12800R

Speed (MHz) 1,600

Speed running in the system (MHz) 1,600

Timing/Latency (tCL-tRCD-tRP-tRASmin) 9-9-9-24

Size (GB) 8

Number of RAM module(s) 20

Chip organization Double-sided

Rank Dual

Operating system

Name Microsoft Windows Server® 2012 R2 Datacenter
Build number 9600

File system NTFS

Kernel 6.2.9600.16452

Language English

RAID controller

Vendor and model number

Dell PERC H710P Mini

Firmware version

21.3.1-0009 06/23/2014

Driver version

6.802.21.00 08/27/2014

Cache size (MB) 1,024

Local storage

Vendor and model number Seagate ST9900806SS
Number of drives 4

Size (GB) 900

RPM 10K

Type SAS

Ethernet adapters

Vendor and model number

Intel Gigabit 1350 4-port

Type Integrated
Driver 12.11.97.1 (08/13/2014)
USB 2.0 ports 4

Figure 12: Detailed information for our test server.
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APPENDIX B— HOW WE CALCULATED OVERALL SYSTEM PERFORMANCE

We included the following benchmarks in our performance/productivity calculation:

e HDXPRT 2012

e PCMark® 8 Work workload

e SYSmark® 2014
e 3DMark® Ice Storm

e 3DMark Ice Storm Extreme
We ran the five benchmarks on the Dell OptiPlex 9030 All-in-One, Dell OptiPlex 9020 Micro, and legacy desktop
tower, repeating each test three times. For our calculations, we selected the median of the three results for each
benchmark and system. We calculated the percentage wins for the Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020
Micro versus the legacy desktop tower on each benchmark. The Dell OptiPlex 9030 All-in-One and Dell OptiPlex 9020
Micro outperformed the legacy desktop tower on all five benchmarks.

We calculated system performance by taking the geometric mean of the percentage wins; that gave us a 145.3
percent system performance improvement for the Dell OptiPlex 9030 All-in-One versus the legacy desktop and a 114.1
percent system performance improvement for the Dell OptiPlex 9020 Micro (see Figure 13).

Dell OptiPlex 9030 All-in-One |  Dell OptiPlex 9020 Micro Lega:z:z:kmp
% %
Score improvement Score improvement Score
over legacy over legacy

desktop tower desktop tower
HDXPRT (Create HD score) 229 129% 193 93% 100
SYSmark (Overall Rating) 1,417 133% 1,334 120% 607
PCMark (Work Score) 3,015 29%) 3,093 32%)| 2,341
3DMark Ice Storm (Median) 57,050 361%)| 40,258 225%| 12,385
3DMark Ice Storm Extreme (Median) 34,812 360%)| 25,834 241%| 7,566
Geometric mean of percentage wins 145.3% 114.1%

Figure 13: System performance improvement based on our benchmark testing.
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APPENDIX C - HOW WE CALCULATED WORKSPACE

Figure 14 shows the dimensions for the three systems and the workspace savings for the Dell OptiPlex 9030 All-
in-One and Dell OptiPlex 9020 Micro. The base of the Dell OptiPlex 9030 All-in-One was roughly the same size as the 9"

circular base of the monitor that we paired with the legacy desktop tower. The legacy desktop tower chassis (17.6" x

17.4" x 7.0") took up 121.7 square inches of desk space. The circular base of the monitor added 63.6 square inches, for a

total footprint of 185.3 square inches. With a footprint of 76.5 square inches, the Dell OptiPlex 9030 All-in-One was

108.8 square inches smaller than the legacy desktop tower—a savings of 59 percent.
The Dell OptiPlex 9020 Micro chassis (1.5” x 7.4" x 7.2") took up 11.1 square inches of desk space. We used
monitors with similar footprints for the Dell OptiPlex 9020 Micro (62.2 square inches) and the legacy desktop tower

(63.6 squares inches). Including the monitors, the footprint of the Dell OptiPlex 9020 Micro was 111.0 square inches

smaller than the footprint of the legacy desktop tower—a savings of 60 percent.

Monitor System Total
Total
Length x Area Length x Area Advantage
. . Area Advantage
width (sq. width (sq. vs. legacy
(inches) inches) (inches) inches) (sq. (sg. inches) (%)
inches) )
Dell OptiPlex S030 All- | ¢ 5, 99 76.5 76.5 108.8 59%
in-One
Dell OptiPlex 9020
Micro 7.1x8.9 63.2 7.4x1.5 11.1 74.3 111.0 60%
(on its narrow side)
Legacy desktop tower 9.0 636 | 17.4x7 121.7 185.3
(circular base)

Figure 14: Dimensions of the three systems and the workspace savings for the Dell OptiPlex 9030 All-in-One and Dell OptiPlex

9020 Micro.
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APPENDIX D — HOW WE TESTED

Configuring the SCCM management environment

Starting from our base Microsoft System Center 2012 Configuration Manager build, we configured our
environment to test KVM Remote Control capability on our target clients. Figure 15 shows our isolated testing
environment, which comprised of one Dell PowerEdge R620 server running Windows Server 2008 R2 Hyper-V® with four
virtual machines. Before configuration, we installed all available Windows updates on our clients and joined each
desktop to the test.local domain. We created Active Directory accounts for AMT provisioning and installed Intel Setup
and Configuration Software (Intel SCS). Next, we provisioned the desktops using Configurator, provided by Intel, to apply
our custom management profile from SCS to each client’s management engine. We provide detailed steps below for
each of these procedures. Finally, Dell Command | Intel vPro Out of Band , which we used to connect to the Dell

OptiPlex 9030 All-in-One and Dell OptiPlex 9020 Micro to complete our out-of-band management testing.

Computer Roles Installed

Description hame Operating system Assigned IP | vCPU | vRAM

Windows Server Active Directory,
Domain controller dc.test.local 5008 R2 Standard Domain Controller, 192.168.1.10 |1 8GB

DHCP
Certificate authority | ca.test.local Windows Server. Certification Authority 192.168.1.15 | 1 8 GB
2008 R2 Enterprise
Database server db.test.local Windows Server SQl Server 2012 192.168.1.20 | 1 16 GB

2008 R2 Standard Enterprise
Windows Server System Center 2012

Management server | cm.test.local 5008 R2 Standard gs;flguranon Manager | 192.168.1.50 | 2 16 GB

Figure 15: The details of our isolated testing environment.

Constructing the infrastructure
Creating Active Directory accounts for AMT provisioning
1. Loginto the Domain Controller using the domain\administrator account.
Open Active Directory Administrative Center.
Under test(local), click New—>Group.
On the Create Group window, for Group name, use Kerberos Admins; for Group type, use security.
Add Kerberos Admins as a member of the Domain Admins group.
Add the computer account of the SCCM server to the Kerberos Admins security group.
Create an Organizational Unit for AMT managed systems. We used AMT

© N Uk wN

Create a security group called AMT
9. Add the Kerberos Admins group to the AMT security group.
Creating certificate templates for OOB management
1. Loginto the Windows 2008 R2 Enterprise server designated for Certificate Authority as
domain\administrator.
2. Click Start->Administrative Tools—> Certification Authority.
3. Right-click on test-CA-CA, and click Properties.
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13.

14.
15.

16.
17.
18.
19.
20.

21.
22.
23.
24.
25.
26.

27.
28.
29.
30.
31.
32.
33.
34.
35.
36.

On the General tab, click View Certificate.

On the Details tab, scroll to and select Thumbprint. Copy the 40-character code displayed in the details. You
will add this information to the AMT BIOS later.

To close the Certificate Authority properties, click OK.

Expand the Certification Authority, and select Certificate Templates.

Right-click Certificate Templates, and select Manage.

Locate Web Server in the list of available certificate templates. Right-click the template, and select Duplicate
Template.

. Select Windows 2003 Enterprise, and click OK.
11.
12.

Change the template name for the AMT Provisioning certificate. We used AMT Provisioning.

On the Subject Name tab, select Build from this Active Directory Information. Select Common Name, and
choose the option UPN.

On the Security tab, add the security group created for the SCCM site server. We used the Kerberos Admin
group. Add the Enroll permission for the security group. Ensure Domain Admins and Enterprise Admins have
Enroll permissions.

On the Extensions tab, select Application Policies, and click Edit.

Click Add. Click New. Type AMT Provisioning forthe name,and2.16.840.1.113741.1.2.3as
the Object Identifier. Click OK.

Ensure AMT Provisioning and Server Authentication are listed, and click OK.

Click OK to close the template properties.

Right-click the AMT Web Server Certificate template, and select Duplicate Template.

Select Windows 2003 Enterprise, and click OK.

Change the template name for the AMT Web Server Certificate. We used AMT Web Server
Certificate Template.

On the General tab, choose the option Publish Certificate in Active Directory.

On the Subject Name tab, select Supply in the request.

On the Security tab, ensure Domain Admins and Enterprise Admins have Enroll permissions.

To close the template properties, click OK.

In Certification Authority, navigate to Certificate Templates.

For both the AMT Provisioning Template, and the AMT Web Server Certificate Template, repeat the
following steps:

Right-click the central panel, and select New—> Certificate Template to Issue.

Select the AMT Provisioning Template.

Click OK.

Log into the management server as domain\administrator.

Click Start->Run. Type mmc and press Enter.

In the mmc console, click File->Add/Remove Snap-in...

Select Certificates, and click Add. Select Computer account. Click Next.

Select Local computer, and click Finish.

Click OK.

Expand Certificates (Local Computer)—>Personal-> Certificates.
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37. In the right panel, click More Actions—>All Tasks>Request a new certificate...
38. Click Next.
39. Accept the defaults, and click Next.
40. Select the new AMT Provisioning certificate. Click Enroll.
41. Click File>Add/Remove Snap-in...
42. Select Certificates, and click Add. Select Computer account. Click Next.
43. Select My user account, and click Finish.
44, Click OK.
45, Expand Certificates—> Personal-> Certificates.
46. In the right panel, click More Actions—=> All Tasks>Request a new certificate...
47. Click Next.
48. Accept the defaults, and click Next.
49. Select the new AMT Provisioning certificate. Click Enroll.
50. Click File>Add/Remove Snap-in...
51. Select Certificates, and click Add. Select My user account. Click Next.
52. Select Local computer, and click Finish.
53. Click OK.
54. Expand Certificates — Current User->Personal—=> Certificates.
55. From Certificates (Local)=>Personal=> Certificates, click and drag the certificate created using the AMT
Provisioning template into Certificates — Current User—> Personal—=> Certificates.
56. Click Close.
Installing Intel Setup and Configuration Software (SCS) 9.1
1. Download IntelSCS_9.1.zip from downloadcenter.intel.com/Detail Desc.aspx?DwnldID=20921.
Extract the contents to C:\IntelSCS_9.1.
Browse to C:\IntelSCS_9.1\IntelSCS\RCS.
Run IntelSCSInstaller.exe.

At the Welcome screen, click Next.
Select | accept the terms of the license agreement, and click Next.
Check the Boxes for Remote Configuration Service (RCS), Database Mode, and Console.
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Enter the credentials of the Domain account that will run the service. We used

test.localladministrator. Click Next.

9. Select db.test.local as the location for the SCS database. This information may populate automatically. Select
Windows Authentication, and click Next.

10. On the Create Intel SCS Database pop-up, click Create Database.

11. On the confirmation screen, click Close.

12. On the confirmation screen, leave the default Installation Folder, and click Install.

13. Once the installation is complete, click Next.

14. Click Finish.

Setting up AMT provisioning with Intel SCS Remote Configuration Service

Creating the configuration profile
1. Onthe management server, launch the Intel Setup and Configuration Console.
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8.
9.

10.
11.
12.
13.
14.
15.

16.

17.

18.
19.
20.
21.
22.

23.
24.

25.
26.
27.
28.
29.

Click Profiles.

To construct a profile for deployment, click New.

For Profile Name, enter a description of the target clients. We used inteltest. Click OK.

On the Getting Started Screen, choose Configuration / Reconfiguration.

On the Optional Settings screen, choose the options Active Directory Integration, Access Control List (ACL),
and Transport Layer Security (TLS), and click Next.

On the AD Integration screen, browse for the OU created for the AMT managed devices. We used OU=AMT,
DC=test, DC=local. Check the box for Always use host name, and click Next.

On the Access Control List screen, click Add.

Select Active Directory User/Group. Click Browse.

Add Kerberos Admin, Domain Admins, or other administrative users groups. Click OK.

For Access Type, select Remote.

Choose the option for PT Administration. Click OK.

Click Next.

On the TLS screen, from the drop-down menu, select the Enterprise Certificate Authority, ca.test.local.
Select the Server Certificate Template to be used to generate certificates for the AMT devices. We selected
AMTWebServerCertificate. Click Next.

On the System Settings screen, choose the options Web Ul, Serial Over LAN, IDE Redirection, and KVM
Redirection.

Select Use the following password for all systems. Enter the password for use after provisioning is complete.
We used P@sswOrd

Click KVM Settings...

Enter the RFB Password for KVM sessions. We used P@sswOrd

Enter the MEBX password. We used P@sswOrd

Uncheck User Consent required before beginning KVM session, and click OK.

Choose the options Enable Intel AMT to respond to ping requests and Enable Fast Call for Help (within the
enterprise network).

To Edit IP and FQDN settings, click Set.

In the Network Settings window, select Use the following as the FQDN, and choose Primary DNS FQDN from
the drop-down menu.

Choose the option, the device and the OS will have the same FQDN (Shared FQDN).

Select Get the IP from the DHCP server.

Select Update the DNS directly or via DHCP option 81. Click OK.

Click Next.

Click Finish.

Configuring the clients
Repeat these steps for each client.

Reserving an IP address in DHCP

1.
2.
3.

On the Domain Controller, run dhcpmgmt.msc.
Expand FQDN-> IPv4->Scope, and click Reservations.
Click More Actions, and click New Reservation.
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4. For Reservation Name, enter the host name of the target client.
5. Enter an IP address to reserve.

6. Enter the MAC address of the target client’s Ethernet port.

7. Click Add.

Configuring policy on the target client
1. Logonto the target client using domain\administrator.

Download and apply applicable driver packages from the manufacturer’s Web site.
Open Windows Firewall with Advanced Security.

Click Firewall Properties.

On the Domain Profile, Private Profile, and Public Profile tabs, set the Firewall state to Off. Click OK.
Set the host name and IP of each virtual machine as described above.

Run lusrmgr.msc.

Select Groups.

. Right-click Administrators, and click Properties.

10. Click Add.

11. Select Object Types, check the box for Computers, and click OK.

12. Disable the wireless adapter.
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Configuring the Configuration Manager Client
1. On the management server, navigate to Program Files=> Microsoft Configuration Manager folder.

2. Copy the Client folder to the target client.
3. Onthe target client, run ccmsetup.exe. This task will run in the background and will take a few minutes to
complete.
4. In Control Panel, open Configuration Manager.
5. On the Site tab, click Configure Settings.
6. For Currently assigned to site code, enter PTL, and click Apply.
7. Inthe Actions panel, run the User Policy Retrieval & Evaluation Cycle and the Machine Policy Retrieval &
Evaluation Cycle.
8. After a few minutes, the Actions panel will populate with more tasks. Run each one of the tasks.
Adding the enterprise certificate authority to the AMT trusted root certification authorities
1. Power on the target client.
2. During POST, press CTRL-P to enter the Intel Management Engine BIOS settings.
3. When prompted for a password, type the default password admin
4. Provide and confirm a new password. We used P@sswOrd
5. Select Intel AMT Configuration. Press Enter.
6. Select SOL/IDER/KVM.
7. All features should be Enabled. To exit the menu, press Esc.
8. Select User Consent.
9. Change User Opt-in to None.
10. Change Opt-in Configurable from Remote IT to Disabled. To exit the menu, press Esc.
11. Change Password Policy to During Setup and Configuration.
12. Select Network Setup.
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13.
14.
15.
16.
17.
18.
19.

20.

21.
22.
23.
24.
25.
26.
27.

28.

29.

30.
31.

Select Intel ME Network Name Settings.

For Host Name, use the same host name used for the operating system.

For Domain Name, enter the domain name. We used test.local

For Shared/Dedicated FQDN, select Shared.

For Dynamic DNS Update, select Enabled. Press Esc to exit the menu.

Select Remote Setup and Configuration. Press Enter.

On Provisioning Server IPv4/IPv6, enter the IP address of the system center server. We used
192.168.1.50

For Provisioning Server FQDN, enter the FQDN of the management server. We entered cm. test.local.
For port number we used 9971

Select TLS PKI.

Select PKI DNS Suffix, and type the FQDN suffix. We used test.local. Press Enter.

Select Manage Hashes.

To add a new hash, press Insert.

Enter a descriptive name for the Enterprise Certificate Authority. We used test.local CA

Press Enter.

Following the syntax example provided in the prompt, enter the 40-character thumbprint previously copied
from the Enterprise CA root certificate. Press Enter.

To set the hash certificate as active, press Y. test.local CA will appear in the list of trusted root authorities
and should be active.

To return to the AMT Configuration Menu, press Esc.

Select Activate Network Access. To confirm, press Y.

To exit, press Esc until prompted. To confirm exit, press Y.

Executing the remote configuration script on the AMT managed client

1.
2.

Log into the AMT managed target client as domain\administrator.
Copy the \Configurator folder from the SCS_9.1 directory located on the management server to C:\ on the
local host.
Open a command prompt as administrator.
Type cd C:\Configurator and press Enter.
Execute the following command:

ACUConfig.exe /lowsecurity /output console /verbose ConfigViaRCSOnly
cm.test.local inteltest
The Configurator utility will contact the Remote Configuration Service and apply the settings configured in
the inteltest profile.

Setting up AMT discovery in SCCM

1.

On the management server, open the SCCM Management Console. Locate the target client in the Devices
panel.

Right-click the headings bar in the Devices panel, and check the entries for AMT Status and AMT Version.
Right-click the server, and select Manage Out of Band—> Discover AMT Status. Click OK.

In the Home menu at the top of the panel, click Refresh.
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5. The Client, Site Code, and Client Activity fields will populate. The AMT Status will change to Externally
provisioned.
Installing Dell Command | vPro Out of Band
1. Download the Dell Command | vPro Out of Band 2.0 from
downloads.dell.com/FOLDER02502830M/2/DCIV_194 ZPE.exe

2. Run DCIV_194_ZPE.exe. Continue as prompted to extract the installation files onto the management server.
3. Run DCIV_Setup_2_0_0.

4. Onthe Dell Command | Intel vPro Out of Band — v 2.0.0.194 window, click Next.

5. On the License Agreement screen, accept the License Agreement, and click Next.

6. On the Ready to Install the Program screen, click Install.

7. When complete, click Finish.

8. Open Dell Command | Intel vPro Out of Band.

9. At the welcome screen, click OK.

10. At the Settings screen, for Data Configuration enter the appropriate information. We used the following:

e System Center SQL server : db.test.local
e System Center database : CM_PTL
11. For Client Credentials, enter the appropriate information. We used the following:
e Operating System Domain: test.local
e Username : administrator
e Password: Passwordl
e Password confirmation : Passwordl
e AMT Management Engine Domain: test.local
e Username:admin
e Password: P@sswOrd
e Password Confirmation : P@ssw0Ord
12. On the Task Queue screen, turn off Refresh Automatically.
13. Set the History Limit to 7.
14. Click OK.

Timing common management tasks on the Dell OptiPlex desktops
Changing one BIOS setting
1. Onthe management server, place the mouse over the Windows start menu icon and start the timer. From
the task bar, click on the icon to open Dell Command | Intel vPro Out of Band.
Select Client Configuration.
Select BIOS Settings.
Click Next.
On the BIOS Settings screen, for Active Processor Cores, for Value to Set select All and check the box to
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Apply the Setting.
Click Next.
7. Onthe Available clients screen, select the target client. Click the right pointing arrow to add the selected

o

client to the list.
8. For asecond client, repeat step 7.
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9. Click Next.
10. Type a description in the Description field. We used test.
11. Click Next.
12. Click Finish.
13. Complete steps 1 through 12 two more times, and report the median of the three runs.
Changing five BIOS settings
1. Onthe management server, place the mouse over the Windows start menu icon and start the timer. From
the task bar, click on the icon to open Dell Command | Intel vPro Out of Band.
Select Client Configuration.
Select BIOS Settings.
Click Next.
On the BIOS Settings screen, for Active Processor Cores, for Value to Set select All and check the box to
Apply the Setting.
For Enable Intel SpeedStep for Value to Set select Enabled and check the box to Apply the Setting.
7. For Enable Intel Virtualization Technology for Value to Set select Enabled and check the box to Apply the
Setting.
8. For Enable MEBx Hotkey for Value to Set select Enabled and check the box to Apply the Setting.
9. For Enable VT for Direct I/O for Value to Set select Enabled and check the box to Apply the Setting.
10. Click Next.
11. On the Available clients screen, select the target client. Click the right pointing arrow to add the selected
client to the list.
12. Repeat step 11 for second client.
13. Click Next.
14. Type a description in the Description field. We used test.
15. Click Next.
16. Click Finish.
17. Complete steps 1 through 16 two more times, and report the median of the three runs.
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Changing boot order
1. Onthe management server, place the mouse over the Windows start menu icon and start the timer. From

the task bar, click on the icon to open Dell Command | Intel vPro Out of Band.

2. Select Client Configuration.
Select Boot Order.

4. Select Internal Optical Drive from the Device list and click the up Arrow button to move the drive up in the
Boot order once.

5. Click Next.

6. Select the target client on the Available clients screen. Click the right pointing arrow to add the selected
client to the list.

7. Repeat step 6 for the second system.

8. Click Next.
9. Type a description in the Description field. We used test.
10. Click Next.
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11.
12.

Click Finish.
Complete steps 1 through 11 two more times, and report the median of the three runs.

Changing the BIOS password

1.

W oK N R WD

10.
11.
12.
13.
14.
15.

On the management server, place the mouse over the Windows start menu icon and start the timer. From
the task bar, click on the icon to open Dell Command | Intel vPro Out of Band.

Select Client Configuration.

Select BIOS Passwords.

For Password task, select Set.

Select Administration.

For New Password, type Passwordl

For Confirm New Password, type Passwordl

Click Next.

On the Available clients screen, select the target client. Click the right pointing arrow to add the selected
client to the list.

Repeat step 9 for the second system.

Click Next.

Type a description in the Description field. We used test.

Click Next.

Click Finish.

Complete steps 1 through 14 two more times, and report the median of the three runs.

Changing the power profile

1.
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8.
9.

10.
11.
12.

On the management server, place the mouse over the Windows start menu icon and start the timer. From
the task bar, click on the icon to open Dell Command | Intel vPro Out of Band.

Select Client Configuration.

Select Power Profile.

For Desktop power policy, select ON in SO; ME Wake in S3, S4-S5.

For Mobile power policy, select No change.

Click Next.

On the Available clients screen, select the target client. Click the right pointing arrow to add the selected
client to the list.

Repeat step 7 for the second system.

Click Next.

Type a description in the Description field. We used test

Click Finish.

Complete steps 1 through 11 two more times, and report the median of the three runs.

Measuring the time to open a KVM session

1.

On the management server, place the mouse over the Windows start menu icon and start the timer. From
the task bar, click on the icon to open Dell Command | Intel vPro Out of Band.

Select Operations.

Select KVM Connect.

On the KVM Connect screen, select the target client, and click Connect.
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5. The KVM will window will appear and connect automatically. When the login screen is visible, stop the
timer.
6. Complete steps 1 through 5 two more times, and report the median of the three runs.

Timing common management tasks on the legacy desktop tower
Changing one BIOS setting
1. With the client at the Windows login screen, start the timer. Restart the computer.
As the system reboots, press F10 to boot into the setup menu.
Select English.
Under the advanced tab, select device options.
Select Multi-processor.
Select Enable
Press F10 to accept.
Press escape, down, and Enter to Save Changes and Exit.
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Press F10 and allow the system to reach the login screen. When the login screen is visible, stop the timer.
10. Complete steps 1 through 9 two more times, and report the median of the three runs.

Changing five BIOS setting
1. With the client at the Windows login screen, start the timer. Restart the computer.

2. Asthe system reboots, press F10 to boot into the setup menu.
3. Select English.

4. Under the Security Tab, select System Security.

5. Select Virtualization Technology (VTx).

6. Select Enable.

7. Press F10 to accept

8. Select Virtualization Technology Direct /0 (VTd)

9. Select Enable.

10. Press F10 to accept.

11. Under the Power tab, select OS Power Management.

12. Select Runtime Power Management.

13. Select Enable.

14. Press F10 to accept.

15. Under the advanced tab, select device options.

16. Select Multi-processor.

17. Select Enable

18. Press F10 to accept.

19. Select Management operations.

20. Select MEBx Setup Prompt.

21. Select Displayed.

22. Press F10 to accept.

23. Press escape, down, and Enter to Save Changes and Exit.

24. Press F10 and allow the system to reach the login screen. When the login screen is visible, stop the timer.
25. Complete steps 1 through 24 two more times, and report the median of the three runs.
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Changing boot order
1. With the client at the Windows login screen, start the timer. Restart the computer.

As the system reboots, press F10 to boot into the setup menu.
Select English.

Under the Storage tab, select boot Order.

Select ATAPI CD-ROM Drive by pressing Enter.

Press up to move the CD-ROM Drive, and press enter.

Press F10 to accept.

Press escape, down, and Enter to Save Changes and Exit.
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Press F10 and allow the system to reach the login screen. When the login screen is visible, stop the timer.
10. Complete steps 1 through 9 two more times, and report the median of the three runs.

Changing BIOS password
1. With the client at the Windows login screen, start the timer. Restart the computer.

As the system reboots, press F10 to boot into the setup menu.

Select English.

Under the Security tab, select Setup Password.

For Enter New Setup Password, type Password1.

For Enter New Password Again, type Password1

Press F10 to accept.

Press escape, down, and Enter to Save Changes and Exit.
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Press F10 and allow the system to reach the login screen. When the login screen is visible, stop the timer.

=
o

. Complete steps 1 through 9 two more times, and report the median of the three runs. Before starting the
next run, remove the added BIOS password.
Changing the power profile
1. With the client at the Windows login screen, start the timer. Restart the computer.
As the system reboots, press Ctrl + P to boot into MEBX.
Enter the Password.
Select Intel ME Configuration.
Press Y to Confirm.
Select Intel ME Power Control.
Press Enter.
Select Desktop: ON in SO, S3, S4-5.
Press ESC three times
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. When asked if you want to exit, press Y and allow the system to reach the login screen. When the login
screen is visible, stop the timer.
11. Complete steps 1 through 10 two more times, and report the median of the three runs.

Measuring system performance
HDXPRT 2012

Setting up the test
1. Insert the HDXPRT v1.1 DVD-ROM into your DVD drive.

2. At the HDXPRT Install screen, click Install HDXPRT.
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3.
4.

Accept the HDXPRT end-user license agreement.
After the setup is complete, select Yes, | want to restart my computer now, and click Finish.

Running the test

1.
2.
3

4.

On the desktop, click the HDXPRT 2012 shortcut.

Click Run HDXPRT.

Enter a test name, choose 3 iterations, and click Run.

The Results Screen automatically appears at the end of a successful run.

BAPCo® SYSmark 2014 v1.0.1.21

Antivirus software conflicts
SYSmark 2014 is not compatible with any virus-scanning software, so we uninstalled any such software that was

present on the desktop PCs before we installed the benchmark.

Pre-installed software conflicts
SYSmark 2014 installs the following applications, which its test scripts employ:

e Adobe® Acrobat® Xl Pro

e Adobe Photoshop® CS6 Extended
e Adobe Premiere® Pro CS6

e Google Chrome™

e Microsoft Excel® 2013

e Microsoft OneNote® 2013

e Microsoft Outlook® 2013

e Microsoft PowerPoint® 2013
e Microsoft Word 2013

e Trimble® SketchUp® Pro 2013
e WinZip® Pro 17.5

Setting up the test

1.
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Disable the User Account Control.

Click Start->Control Panel.

At the User Accounts and Family Safety settings screen, click Add or remove user account.
At the User Account Control screen, click Continue.

Click Go to the main User Accounts page.

At the Make changes to your user account screen, click Turn User Account Control on or off.
At the User Account Control screen, click Continue.

Uncheck Use User Account Control to help protect your computer, and click OK.

At the You must restart your computer to apply these changes screen, click Restart Now.

10. Purchase SYSmark 2014 v1.0.1.21 from bapco.com/products/sysmark-2014 and install with default settings.
11. To launch SYSmark 2014, double-click the desktop icon, and select Configuration.

12. Select all options, and click Save.

Running the test

1.
2.

Double-click the desktop icon to launch SYSmark 2014.
Make sure Office Productivity, Media Creation, and Data/Financial Analysis are selected.
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Enter a Project name.

Select 3 Iterations, check the box beside Conditioning Run and beside Process Idle Tasks, and click Run
Benchmark.

When the benchmark completes and the main SYSmark 2014 menu appears, click Save FDR to create a
report.

Futuremark® PCMark 8 v2.3.293
Setting up the test

1.
2.
3.
4.

Download the PCMark 8 installer exe Windows package from www.futuremark.com/benchmarks/pcmarks.
Double-click the PCMark installer exe file to install PCMark 8 with the default options.

Click the PCMark 8 desktop icon to launch PCMark 8. Enter the registration code, click Register, and click OK.
Exit PCMark 8.

Running the test
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3DMark

Boot the system and type CMD to bring up a command prompt.

To open App options, right-click the Command Prompt app.

Click Run as administrator.

Type Cmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.

After the command completes, wait 5 minutes before running the test.

Double-click the PCMark 8 desktop icon to launch the benchmark.

Select the Home test suite.

Click Run Conventional.

. When the benchmark run completes, record the results.
. Shut down the system.
. Complete steps 1 through 11 two more times for the Home test suite, and report the median of the three

runs.

. After completing the three runs of the Home test suite, perform steps 1 through 12 for the Creative, Work,

Storage, and Application suites.

Installing 3Dmark v1.4.828

14.
15.
16.
17.
18.
19.
20.
21.
22.

Download the 3DMark installer from www.futuremark.com/benchmarks/3dmark/all.
To install 3DMark with the default options, double-click the 3DMark installer exe file.
At the Welcome screen, click Next.

At the License Agreement screen, click | accept the terms of the license agreement, and click Next.

At the Setup Type screen, click Express, and click Next.

At the Ready to Install the Program screen, click Install.

At the Setup Complete screen, click Finish.

To launch 3DMark, double-click the 3DMark desktop icon. Enter the registration code, and click Register.
Exit 3DMark.

Running 3DMark v1.4.828

1.

Boot the system and bring up a command prompt:
a. Type CMD into the Start menu search bar.
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b. Right-click the Command Prompt app.
c. Click the Run as administrator button.
TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks
Do not interact with the system until the command completes.
After the command completes, wait 5 minutes before running the test.
To launch the benchmark, double-click the 3DMark desktop icon.
At the 3DMark Benchmark screen, click Run Ice Storm Unlimited.
When the benchmark run completes, record the results.
Repeat steps 6 and 7, except run Ice Storm Extreme.
Perform steps 1 through 8 two more times, and report the median of the three runs.

Measuring power consumption

Test requirements
e ExTech 380801 True RMS Power Analyzer

e PassMark® BurnIinTest Professional

e Thermometer

Measuring system temperature while idle and under load
Setting up the test

1.
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10.
11.
12.
13.

14.
15.

Using a power strip, plug the system under test (and monitor if used) into the ExTech.
Plug the ExTech into its own circuit.

On the system used to monitor the ExTech, open the Power Analyzer.

From the drop-down Option menu, select Sample Rate.

For the sample rate, enter 1.0, and select OK.

On the systems under test, set the power plan to the manufacturer’s default setting. Set the display
brightness to 100 percent:

Click Start.

In the Start menu’s quick search field, type Power Options

Move the Screen brightness slider all the way to the right.

Set the remaining power plan settings as follows:

e Dim the display: Never

e Turn off the display: Never

e Put the computer to sleep: Never

Disable the screen saver.
Download PassMark Burnin Test Professional V7 from www.passmark.com/products/pt.htm.

To run setup, double-click bitpro_x64.exe.

At the Welcome screen, click Next.

Accept the license agreement, and click Next.

At the Choose Install Location screen, accept the default location of C:\Program Files\BurnInTest, and click
Next.

At the Select Start Menu Folder screen, click Next.

At the Ready to Install screen, click Install.
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16.

17.
18.
19.
20.
21.
22.
23.

At the Completing the BurninTest Setup Wizard screen, deselect View Readme.txt, and click Finish to launch
PerformanceTest.

At the Purchasing information screen, copy and paste the Username and key, and click Continue.

At the Key accepted screen, click OK.

From the Configuration menu item, select Test selection and duty cycles.

Change the Auto Stop After field to 180.

Select CPU, 2D Graphics, 3D Graphics, RAM, and Disk(s), and deselect all other subsystem:s.

Set load to 100, and click OK.

From the Configuration menu item, select Test Preferences and set or verify the following by clicking on
each tab:

e Disk: select C: drive

e logging: select Turn automatic logging on

e 2D Graphics: select All available Video Memory

e 3D Graphics: defaults

o RAM: select Multi-Process Torture Test

Running the test
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Boot the system and bring up an administrative command prompt:

TypeCmd.exe /c start /wait Rundll32.exe advapi32.dll,ProcessIdleTasks

Do not interact with the system until the command completes.

After the command completes, wait 5 minutes before running the test.

On the ExTech power monitor, enter a name for the test run.

Report the room temperature, and in the ExTech Power Analyzer window, click Start Recording

After 30 minutes, record the room temperature.

After 1 hour, record the room temperature and in the ExTech Power Analyzer window, click Stop Recording.
Record the average watts of the run as Idle Power consumption.

. Record the average of the recorded room temperatures as the Idle Room Temperature.

. On the ExTech power monitor, enter a name for the Under Load test run.

. Double-click the PassMark BurninTest desktop icon.

. In the BurnInTest V7.0 Pro screen, click Start Selected Tests.

. Report the room temperature, and in the ExTech Power Analyzer window, click Start Recording.

. After 30 minutes, record the room temperature.

. After 1 hour, record the room temperature, and in the ExTech Power Analyzer window, click Stop Recording.
. Record the average watts of the run as Under Load Power Consumption.

. Record the average of the recorded room temperature as the Under Lo

. ad Room Temperature.

. Power the system down and let it rest for one hour.

. Complete steps 1 through 19 two more times, and report the median of the three Idle and Under Load runs

as well as the average temperature for each median run.
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APPENDIX E— BENCHMARK INFORMATION

About HDXPRT 2012
The High Definition Experience & Performance Ratings Test (HDXPRT) 2012 is a benchmark that evaluates the

capabilities of PCs in consumer digital media uses, divided into the following categories:

e Media Organizer

e Media Creator

e Photo Blogger

e Video Producer

e Music Maker

For more information on HDXPRT 2012, see
principledtechnologies.com/benchmarkxprt/whitepapers/2012/HDXPRT 2012 White Paper.pdf.

About BAPCo SYSmark 2014

According to BAPCo, “SYSmark 2014 is an application-based benchmark that reflects usage patterns of business

users in the areas of office productivity, media creation, and data/financial analysis.” The benchmark features notable
applications from these fields. SYSmark 2014 generates a score from the times the tested system takes to complete each
individual operation in each scenario. For more information on this benchmark, see bapco.com/products/sysmark-2014.

About Futuremark PCMark 8 v2.2.282

According to Futuremark, “PCMark 8 is the latest version in our series of industry standard PC-benchmarking

tools.” PCMark 8 evaluates the performance of PCs from tablets to desktops by using real-world tasks and applications.
Applications are divided into scenarios that reflect common usage in different capacities. For our testing, we used the
Work portion of the benchmark, which offers workloads that test a system's ability to perform basic office work tasks,
such as writing documents, browsing Web sites, creating spreadsheets, and using video chat.
About Futuremark 3DMark (2013) v1.4.778

Futuremark 3DMark v1.4.778 is a collection of benchmarks designed to rate the graphics performance of
smartphones, tablets, notebooks, laptops, desktops, or high-performance gaming PCs. 3DMark includes benchmarks
designed for Windows, Apple®, and Android™ devices. The Ice Storm portion of 3DMark includes 720p graphics tests to
measure GPU performance and a physics test to stress CPU performance. Ice Storm is available for Windows, iOS, and
Android smart phones and tablets. It uses a DirectX® 11 feature level 9 for Windows and OpenGL® ES 2.0 for iOS and
Android systems. Ice Storm Extreme increases the rendering resolution to 1080p and uses higher quality textures and
post-processing effects in the Graphics tests.

For more information on 3DMark, see www.futuremark.com/benchmarks/3dmark.
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ABOUT PRINCIPLED TECHNOLOGIES

» We provide industry-leading technology assessment and fact-based
Principled marketing services. We bring to every assighnment extensive experience
‘ ITechnoIogies® with and expertise in all aspects of technology testing and analysis, from
researching new technologies, to developing new methodologies, to

. . testing with existing and new tools.
Principled Technologies, Inc.

1007 Slater Road, Suite 300
Durham, NC, 27703 When the assessment is complete, we know how to present the results to

www.principlectechnologies.com a broad range of target audiences. We provide our clients with the
materials they need, from market-focused data to use in their own
collateral to custom sales aids, such as test reports, performance
assessments, and white papers. Every document reflects the results of
our trusted independent analysis.

We provide customized services that focus on our clients’ individual
requirements. Whether the technology involves hardware, software, Web
sites, or services, we offer the experience, expertise, and tools to help our
clients assess how it will fare against its competition, its performance, its
market readiness, and its quality and reliability.
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published over a thousand articles on a wide array of technology subjects.
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Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER,
PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND
ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE.
ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED
TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR
DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES,
INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S
TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.
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